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Chapter 1

Release Notes

What's New
The What's New is available on the AMD website at AMD Vivado™ 2025.2 What's New.

Known Issues
Vivado Design Suite Tools Known Issues can be found at Answer Record 000037546.

Important Information
Vivado Design Suite Updates
• From 2024.2, Vivado supports Advanced Flow Place & Route for Versal devices. Upgrading a

Versal project to Vivado 2024.2 makes it incompatible with any prior Vivado versions. More
details can be found at Answer Record 000036830 - Migrating Versal Vivado projects to
Vivado 2024.2.

• The format of the AMD IP configuration file has been changed from XML to JSON to improve
revision control capabilities and loading times.

• For information on the IP change log see the All IP Change Log Information. This Answer
Record contains a comprehensive list of IP change log information in a single location, which
allows you to see all IP changes without having to install the Vivado Design Suite.

Licensing
The Vivado 2021.1 and beyond releases introduce the following changes in licensing that are
listed below:

• Flexera version for license management tool has been upgraded to 11.17.2.0.
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• Floating license users must upgrade licensing utilities to Flex 11.17.2.0. These new licensing
utilities are available on the AMD Downloads Website.

Note: Flex version upgrade does not affect valid licenses. Existing licenses work after the Vivado 2021.1
licensing utilities upgrade.

Installer
Library Name Change

The Vivado 2025.2 renamed the kernel shared library required by Xilinx Simulator Interface (XSI)
to call functions. You find the library at <Vivado Installation Root>/lib/<platform>.
This change gives users greater ease of use which is lnx64.o or win64.o.

The library name changed from librdi_simulator_kernel.so (Linux) to
libxv_simulator_kernel.so (Linux) and librdi_simulator_kernel.dll (Windows)
to xv_simulator_kernel.dll (Windows).

Installer Changes

Starting with the 2025.1 release, AMD optimized the folder structure of its tools for improved
usability. AMD Vivado™ revised the structure: <Version>/Vivado. We designed this change
to give users greater ease of use when managing multiple versions of our products. We
elevated some folders, to a parallel level with our product, minimizing duplication, and reducing
installation size. Uninstalling a product from a destination results in removal of all products
installed in that location.

Note: The default installation directory on Windows has been updated to C:\AMDDesignTools. Users
can customize the directory name during installation as needed.

Note: Only changes in the Installation directory. The directory structure that are part of user profile
directory, such as C:\Users\<username>\AppData\Roaming\Xilinx on Windows and/home/
<username>/.Xilinx on Linux remains same.

The 2020.2 release introduced the new HLS product with support for both the AMD Vitis™
unified software platform and the AMD Vivado™ tools. From the 2025.2 release onwards, AMD
Vitis™ integrates with HLS. You can notice the Vitis folder for even Vivado installations. You need
to update any custom setup scripts from the previous release.

The AMD 2025.2 settings.sh scripts automatically handle this.

Note: AMD Vivado™ only tool installation now includes AMD Vitis™ folder to optimize the folder structure
dependencies.

Note: The product you have chosen to install selects the End User License Agreement (EULA) and third-
party notices.
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Vivado Naming Conventions
The following are the required naming conventions when working with the Vivado Design Suite.
Failing to follow these naming conventions can introduce potential risk to the design or the tool,
and cause unpredictable behavior in the design flow.

• Source files names must start with a letter (A-Z, a-z). The file names must contain only
alphanumeric characters (A-Z, a-z, 0-9) and underscores (_).

• Output files names must start with a letter (A-Z, a-z). The file names must contain only
alphanumeric characters (A-Z, a-z, 0-9) and underscores (_).

• Project names must start with a letter (A-Z, a-z). The file names must contain only
alphanumeric characters (A-Z, a-z, 0-9) and underscores (_).

• Project directory names must start with a letter (A-Z, a-z). The file names must contain only
alphanumeric characters (A-Z, a-z, 0-9), tilde (~), and underscores (_).

CAUTION! The Windows operating system has a 260 character limit for path lengths which can affect
the Vivado tools. To avoid this issue, use the shortest possible names and directory locations when creating
projects, defining IP or managed IP projects, or creating block designs.

The system does not support the following characters for project, file, or directory names.

• ! # $ % ^ & * ( ) ` ; < > ? , [ ] { } ' " |

• tab (\t)

• return (\r)

• new line (\n)

• / or \ (As part of the directory or file name rather than as a path delimiter)

The directory name does not support this character.

• . (dot as terminal character)

This file/project name does not support this character.

• @

Note: The Vivado IDE does not support the @ character for new file or project names. The Vivado IDE
does allow an existing file on disk that uses the @ character to be added to a project. The Vivado IDE
can open a project that includes the @ character in the project name. Using the Tcl Console, you can
create a project with a name that contains the @ character.

IMPORTANT! The Windows operating system supports spaces in directory and file names. However, you
need to avoid using spaces to preserve portability of the project or files between the Windows and Linux
operating systems.
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The Vivado Design Suite supports the use of forward slashes (/) as path delimiters for both
Windows and Linux platforms. The Windows platform only allows backslashes (\) as path
delimiters.

Any characters not explicitly mentioned above are not supported for project, file, or directory
names.

Vivado Design Suite Documentation Update
Quality Improvements to the User Guides

The Vivado user guides are a great resource with important information for using Vivado. For
2025.2, we improved the content in the most used guides to better meet the needs of our
customers. The changes include reducing the length of long sentences, rewriting to be clearer,
correcting typos, and generally making the easier to read and understand.

• Vivado Design Suite Tcl Command Reference Guide (UG835)

• Vivado Design Suite User Guide: Logic Simulation (UG900)

• Vivado Design Suite User Guide: Synthesis (UG901)

• Vivado Design Suite User Guide: Using Constraints (UG903)

• Vivado Design Suite User Guide: Design Analysis and Closure Techniques (UG906)

• Vivado Design Suite User Guide: Programming and Debugging (UG908)

• Vivado Design Suite Properties Reference Guide (UG912)

• Vivado Design Suite 7 Series FPGA and Zynq 7000 SoC Libraries Guide (UG953)

• Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973)

• Vivado Design Suite User Guide: Designing IP Subsystems Using IP Integrator (UG994)

In the 2025.2 Vivado Design Suite Documentation release, not all documentation is available at
first customer ship. Select the Update Catalog button in DocNav to stay up-to-date with the
2025.2 documentation suite.

Navigating Content by Design Process
AMD Adaptive Computing documentation is organized around a set of standard design
processes to help you find relevant content for your current development task. You can access
the AMD Versal™ adaptive SoC design processes on the Design Hubs page. You can also use the
Design Flow Assistant to better understand the design flows and find content that is specific to
your intended design needs. This document covers the following design processes:
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• Hardware, IP, and Platform Development: Creating the PL IP blocks for the hardware
platform, creating PL kernels, functional simulation, and evaluating the AMD Vivado™ timing,
resource use, and power closure. Also involves developing the hardware platform for system
integration. Topics in this document that apply to this design process include:

• What's New

• Supported Devices

• System Integration and Validation: Integrating and validating the system functional
performance, including timing, resource use, and power closure. Topics in this document that
apply to this design process include:

• What's New

• Supported Devices

• Board System Design: Designing a PCB through schematics and board layout. Also involves
power, thermal, and signal integrity considerations. Topics in this document that apply to this
design process include:

• What's New

• Supported Devices
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Chapter 2

Requirements and Setup

Supported Operating Systems
AMD supports the following operating systems on x86-64 processor architectures.

• Microsoft Windows Professional/Enterprise 10.0 22H2 Update

• Microsoft Windows 11.0 23H2 and 24H2 Update

• Red Hat Enterprise Workstation/Server 8.10, 9.4, 9.5, 9.6, and 10.0 (64-bit), English

• SUSE Linux Enterprise 15 SP4,15 SP6, and 15 SP7 (64-bit), English

• Amazon Linux 2 AL2023 LTS (64-bit)

• AlmaLinux 8.10, 9.4, 9.5, 9.6, and 10.0 (64-bit)

• Ubuntu Linux 22.04.3, 22.04.4, 22.04.5, 24.04, 24.04.1, and 24.04.2 (64-bit), English

• Rocky Linux 8.10, 9.6, and 10.0

TIP: Ubuntu OS requires the libtinfo.so.5  as described in AR# 76616.

Note: Refer to PetaLinux Tools Documentation: Reference Guide (UG1144) for more information on
Installation Requirements for supported Operating Systems with PetaLinux.

Note: Refer to Vitis Model Composer Tutorial (UG1498) for Vitis Model Composer OS support details.

Supported Devices
The following sections list architecture support for commercial products in the AMD Vivado™
ML Editions tool versus all other Vivado ML Editions. In the Vivado ML Editions, AMD
Automotive supports all non-commercial devices as production devices in the tools.

Note: AMD Alveo™ and AMD Kria™ cards are included as part of the ML Standard Edition.

Note: Vivado no longer requires a license for ML Standard Edition starting in 2016.x.
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Table 1: Architecture Support

Device Vivado ML Standard Edition Vivado ML Enterprise Edition
AMD Zynq™ SoC Zynq 7000 SoC Devices

• XC7Z010, XC7Z015, XC7Z020,
XC7Z030, XC7Z007S, XC7Z012S, and
XC7Z014S

Zynq 7000 SoC Devices
• All

AMD Zynq™ UltraScale+™ MPSoC UltraScale+ MPSoC Devices
• XCZU1EG, XCZU1CG, XCZU2EG,

XCZU2CG, XCZU3EG, XCZU3CG,
XCZU3TEG, XCZU3TCG, XCZU4EG,
XCZU4CG, XCZU4EV, XCZU5EG,
XCZU5CG, XCZU5EV, XCZU7EV,
XCZU7EG, and XCZU7CG

UltraScale+ MPSoC Devices
• All

Zynq UltraScale+ RFSoC UltraScale+ RFSoC Devices
• None

UltraScale+ RFSoC Devices
• All

AMD Virtex FPGA Virtex 7 FPGA Devices
• None
Virtex UltraScale FPGA Devices
• None

Virtex 7 FPGA Devices
• All
Virtex UltraScale FPGA Devices
• All
Virtex UltraScale+ FPGA Devices
• All
Virtex UltraScale+ HBM Devices
• All
Virtex UltraScale+ 58G Devices
• All

AMD Kintex FPGA Kintex 7 FPGA Devices
• XC7K70T, XC7K160T
Kintex UltraScale FPGA Devices
• XCKU025, XCKU035
Kintex UltraScale+ FPGA Devices
• XCKU3P, XCKU5P

Kintex 7 FPGA Devices
• All
Kintex UltraScale FPGA Devices
• All
Kintex UltraScale+Devices
• All

AMD Artix 7 FPGA Artix 7 FPGA Devices
• XC7A12T, XC7A15T, XC7A25T,

XC7A35T, XC7A50T, XC7A75T,
XC7A100T, XC7A200T

Artix 7 FPGA Devices
• All

AMD Artix™ UltraScale+ FPGA Artix UltraScale+ Devices
• XCAU10P, XCAU15P, XCAU7P,

XCAU20P, and XCAU25P

Artix UltraScale+ Devices
• All

AMD Spartan™ 7 FPGA Spartan 7 Devices
• XC7S6, XC7S15
• XC7S25, XC7S50
• XC7S75, XC7S100

Spartan 7 Devices
• All

AMD Spartan™ UltraScale+™ FPGA Spartan UltraScale+ Devices

• XCSU10P

• XCSU25P

• XCSU35P

Spartan UltraScale+ Devices

• All
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Table 1: Architecture Support (cont'd)

Device Vivado ML Standard Edition Vivado ML Enterprise Edition
AMD Alveo™ card Alveo Devices

• All
Alveo Devices
• All

AMD Kria™ SOM Kria Devices
• All

Kria Devices
• All
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Table 1: Architecture Support (cont'd)

Device Vivado ML Standard Edition Vivado ML Enterprise Edition
AMD Versal™ adaptive SoC N/A AI Core Series Devices

• XCVC1502
• XCVC1702
• XCVC1802
• XCVC1902
• XCVC2602
• XCVC2802
• XQVC1702
• XQVC1902
• XQRVC1902
Prime Series Devices
• XCVM1102
• XCVM1302
• XCVM1402
• XCVM1502
• XCVM1802
• XCVM2152
• XCVM2202
• XCVM2302
• XCVM2502
• XCVM2902
• XQVM1102
• XQVM1402
• XQVM1502
• XQVM1802
AI Edge Series Devices
• XAVE1752
• XAVE2002
• XAVE2102
• XAVE2202
• XAVE2302
• XAVE2602
• XAVE2802
• XCVE1752
• XCVE2002
• XCVE2102
• XCVE2202
• XCVE2302
• XCVE2602
• XCVE2802
• XQVE2102
• XQVE2302
• XQRVE2302
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Table 1: Architecture Support (cont'd)

Device Vivado ML Standard Edition Vivado ML Enterprise Edition
AMD Versal™ adaptive SoC Prime Series Devices

• XCVM1102

Edge Series Devices

• XCVE2002

• XCVE2102

• XCVE2202

• XCVE2302

Premium Series Devices
• XCVP1002
• XCVP1052
• XCVP1102
• XCVP1202
• XCVP1402
• XCVP1502
• XCVP1552
• XCVP1702
• XCVP1802
• XCVP1902
• XCVP2502
• XCVP2802
• XQVP1052
• XQVP1202
• XQVP1402
• XQVP1502
• XQVP1702
• XQVP2502
HBM Series Devices

• XCVH1522

• XCVH1542

• XCVH1582

• XCVH1742

• XCVH1782

Gen 2 Prime Series Devices

• XC2VM3558

• XC2VM3858

Gen 2 AI Edge Series Devices

• XC2VE3504

• XC2VE3558

• XC2VE3804

• XC2VE3858

Note: AMD Vitis™ unified software platform and Vivado platform board design flows support the AMD
UltraScale+™ device.
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Note: Some devices can have bitstream generation under license control. Contact your sales FAE for
access.

Compatible Third-Party Tools
Table 2: Compatible Third-Party Tools

Third-Party Tool Red Hat 64-bit
Linux SUSE Linux Windows 10 64-

bit Ubuntu

Simulation

Mentor Graphics ModelSim DE (2025.2) Yes N/A Yes N/A

Mentor Graphics Questa Advanced
Simulator (2025.2)

Yes N/A Yes N/A

Cadence Xcelium Parallel Simulator
(25.03.002)

Yes N/A N/A N/A

Synopsys VCS (X-2025.06-SP1) Yes N/A N/A N/A

The MathWorks MATLAB® and
Simulink® (R2025a, R2024b, and
R2024a)

Yes Yes Yes Yes

Aldec Active-HDL (16.0)1 N/A N/A Yes N/A

Aldec Riviera-PRO (2024.10) Yes N/A Yes N/A

Synthesis2

Synopsys Synplify base/elite/apex
(W-2025.03-SP1)3

Yes Yes Yes N/A

Equivalence Checking

Questa Equivalent FPGA (formerly
OneSpin EC FPGA) (2025.2)

Yes Yes Yes N/A

Notes:
1. Support for Aldec simulators is offered by Aldec.
2. Most Vivado IPs can only be synthesized by Vivado synthesis, because the RTL source can include encrypted files. To

use this IP in a third-party synthesis flow, netlist can be exported from the Vivado tool in a suitable format for use in
the third-party synthesis project.

3. Contact Synopsys for availability of Synplify Overlay or Service Pack.
4. Refer to the Vitis Model Composer User Guide (UG1483) for the Vitis Model Composer OS support details.

Note: The versions listed in the preceding table are the minimum required versions to use with the Vivado
tools. Testing is limited to current versions.

Note: Contact simulation vendor to check if you need license for using advanced simulation features. 
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System Requirements
This section provides information on system memory requirements, cable installation, and other
requirements and recommendations.

System Memory Recommendations
For memory recommendations for the Vivado Design Suite tools, see Memory
Recommendations.

Operating Systems and Available Memory

The Microsoft Windows and Linux operating system (OS) architectures have limitations on the
maximum memory available to an AMD program. Users targeting the largest devices and most
complex designs can encounter this limitation. The Vivado Design Suite has optimized memory
and enabled support for applications to increase RAM memory available to AMD tools.

Cable Installation Requirements
Platform Cable USB II is a high-performance cable that enables AMD design tools to program
and configure target hardware.

Note: AMD no longer supports the Parallel Cable IV for debugging or programming.

RECOMMENDED: To install Platform Cable USB II, a system must have at least a USB 1.1 port. For
maximum performance, AMD recommends using Platform Cable USB II with a USB 2.0 port.

The cable officially supports the 64-bit versions of the following operating systems:

• Windows 10

• Windows 11

• Red Hat Linux Enterprise

• SUSE Linux Enterprise 15

• Ubuntu

• AlmaLinux

• Rocky

Additional platform-specific notes are as follows: required root privileges, and for additional
information regarding the AMD cables, see the Platform Cable USB II Data Sheet (DS593).

Chapter 2: Requirements and Setup

UG973 (v2025.2) November 20, 2025
Vivado Design Suite 2025.2 Release Notes  14Send Feedback

https://www.amd.com/en/products/software/adaptive-socs-and-fpgas/vivado/vivado-buy.html#memory
https://www.amd.com/en/products/software/adaptive-socs-and-fpgas/vivado/vivado-buy.html#memory
https://docs.amd.com/access/sources/ud/document?url=ds593&ft:locale=en-US
https://www.amd.com/en/forms/feedback/document-feedback.html?docId=UG973&Title=%20Vivado%20Design%20Suite%20User%20Guide&releaseVersion=2025.2&docPage=14


Equipment and Permissions
The following table lists related equipment, permissions, and network connections.

Table 3: Equipment and Permissions Requirements

Item Requirement
Directory permissions Write permissions must exist for all directories containing design files to be edited.

Monitor 16-bit color VGA with a minimum recommended resolution of 1024 by 768 pixels.

Ports To program devices, you must have an available parallel or USB port appropriate for your AMD
programming cable. Specifications for ports are listed in the documentation for your cable.

Note: The cable driver software is compatible only with Windows 10. If you are using a different
operating system or a different version of Windows, the cables do not function properly.

Note: Exceed, ReflectionX, and XWin32 are not supported.

Network Time Synchronization

Locate the design files on the software machine and ensure the clock settings of all network
machines are synchronized, as the software requires regular time synchronization across
machines to function properly.

Checking Required Libraries
Some Linux operating systems require dependent libraries. The installation process can fail in
case of missing libraries. In case of an error during the installation process, run installLibs.sh.
This installs the missing dependent libraries required by the Vitis unified software platform and
Vivado tools.

For prior-installation issues:

For both the Unified Single File Download (SFD) and the Webinstaller, the installLibs.sh
script is located at the image root. To access the image root area with the Webinstaller, use the
following command in batch mode on a Linux machine to extract the image.

<Download Dir>/FPGAs_AdaptiveSoCs_Unified_202X.Y_MMDD_HHMM_Lin64.bin –keep 
--noexec --target <WI Client Dir>

For post-installation issues:

In 2025.x and newer releases, the installLibs.sh script is located in <install_location>/
Xilinx/202x.x/Vivado/scripts and/or <install_location>/Xilinx/202x.x/
Vitis scripts.
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The installLibs.sh script for previous versions is located at: <install_location>/
Xilinx/Vitis/202x.x/scripts.

Note: This script is not required on Windows.
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Chapter 3

Obtain and Manage Licenses

Create and Generate a License Key File
Lock your certificate-based license using the Flexera Host ID (Ethernet, MAC ID, Drive Serial
Number, or Dongle ID). You do not need to enter the AMD License Management site from one of
our utilities.

Note: Follow the steps below to generate a floating certificate-based license.

1. Go to Product Licensing.

If prompted, sign in with your AMD credentials and confirm any necessary information to
continue.
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• If you already have an AMD user account, enter your E-mail Address and password, and
then confirm your contact information is current.

• If you do not have an account, click the Create Account link and register.

• Provide the necessary info for Name and Address verification for the U.S Government
Export Approval form and click Next.

The display shows the Product Licensing page.

2. Select a product licensing account from the Account drop-down list.
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Note: This selection is not available if you are entitled to evaluation or free products only.

3. (Optional) Enter product voucher codes for design tools or IP product licenses purchased
with kits or for tools purchased from the AMD online store. If you have a product voucher
card, you can enter the voucher code on the card into the associated text field and click
Redeem Now.

AMD and partners ship product vouchers for design tools and IP with development boards
or design kits. This places the corresponding design tools or IP product entitlement in the
product entitlement table which you can use to generate a license key.

4. (Optional) Add evaluation or No Charge IP product entitlements to the product entitlement
table.

To add Evaluation and No Charge IP to the list of product entitlements, click the Search Now
button. The Search Now button in the Add Evaluation and No Charge IP Cores section of the
page. This opens an IP product finder tool.

5. Make your product selections from the Certificate-Based entitlement table.

The following types of product entitlements are available:

• Full (purchased)

• No Charge

Note: Full and No Charge licenses have a subscription period of one year.

• Evaluation

Note: Design tool evaluation is for 30 days and IP evaluations are for 120 days.

The Vivado Design Suite: 30-Day Evaluation License evaluation product entitlement
provides access to all the capabilities in the Vivado Design Tools. Your product licensing
account automatically includes this product entitlement.
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Products with a status of Current are within their warranty period. Products with a status of
Expired have a warranty period end date that has passed. AMD generates licenses for either
Current or Expired product entitlements if seats are available.

6. Select the number of seats required for each product license.

This applies only to floating licenses, while all node-locked licenses are limited to one seat.
The system automatically tracks the number of seats available for a product entitlement. By
default, the Requested Seats field is set to zero, but you can enter any number up to the
total number of seats remaining on the product entitlement. A product is removed from the
product entitlement table after all seats are generated.

For design tools, available seats represents the number of seats available for licensing over
the total number of seats purchased. For IP, seats are managed according to the terms of the
site-wide license agreement.

7. Click the Generate License button corresponding with the type of license file you are
generating.

Note: You cannot combine floating/server licenses and node-locked/client licenses in the same license
file. When you select an entitlement containing only one license type, the system deactivates the
Generate License button for the other license type.

In the next window, you define the product and system that you are generating the license
for.

8. Enter system information.
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For floating certificate-based licenses, the first field is redundancy. A triple-redundant server
configuration, also known as a triad, provides a fail over for the license manager software. As
long as two of the three servers are running, the license manager can continue to run. This
does not apply to node-locked licenses. The system information is pre-populated in the Host
ID drop-down menu if you arrived at the Product Licensing Site from a link within the Vivado
License Manager.

a. If you do not have pre-populated system information, or if you want to add a different
host, click Select a Host and then click Add a Host.

b. Enter information about the host.

The Host ID value uniquely identifies the machine to which your design tools or IP is
licensed. You can choose a Host ID Type to be a MAC address, a hard drive serial number
or a dongle ID.

Note: Not all host ID types are supported for all operating systems. The easiest way to obtain your
host ID is to run Vivado License Manager on the machine that serves as the license host.

9. (Optional) Add a comment.

Adding a comment to the license key makes it easier for the administrator to track the
allocation of the design tools and IP product entitlements among users.
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10. Click Next.

11. Review your selections, and click Next.

12. Accept the licensing agreement.

Note: If you license IP products, you must accept the terms of the associated IP product EULAs before
the license file can be generated.

When you finish generating the licenses, you receive a confirmation message summarizing your
licensing activity.

You will receive an email from xilinx.notification@entitlenow.com with the license
file, which you must save to your machine.

TIP: If you do not receive your license by email, you can download it directly from the Product Licensing.
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Installing Your License Key File

Install Certificate-Based Node-Locked License Key File

After generating a license file, you will receive an email from ‘xilinx.notification@entitlenow.com’.

1. Save the license file (.lic) attached to the e-mail to a temporary directory on your local
system.

2. Run the Vivado License Manager:

• For Windows 11 or earlier: Select Start → All apps → Xilinx Design Tools → Vivado 2025.2 
→ Manage AMD Licenses.

• For Linux: Type vlm in a command-line shell.

3. On the left hand pane of Vivado License Manager, expand Getting a License and select Load
License.

4. If you received a certificate license (.lic) file, click the Copy License button on the Load
License screen.

5. Browse to your license file (Xilinx.lic) and click Open.

This action copies the license file to the %APPDATA%\XilinxLicense (Windows) or
<Home>/.Xilinx directory of your computer where it is automatically found by the AMD
tools.

6. Click OK.

Serving Certificate-Based Floating Licenses

For existing FLEXnet license servers serving certificate-based licenses, a common practice is to
copy the contents of the license file, mailed from xilinx.notification@entitlenow.com, into the
existing license file on your FLEXnet server.

Note: Restart the floating license server to ensure the new AMD licenses are enabled.

Serve New License Servers

1. Go to the AMD Downloads Website.

2. In License Management Tools, select and download the applicable AMD FLEXnet license
utilities for your server's operating system.

3. Unzip these utilities into a destination directory.

RECOMMENDED: AMD recommends you place this directory into your application search path
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4. After the FLEXnet utilities are installed, run the following commands to start the floating
license server:

• For Linux, enter <Server Tool directory>/lnx64.o/lmgrd -c
<path_to_license>/<license file>.lic -l <path_to_license>/<log
filename>.log.

• For Windows, enter <Server Tool directory>/lmgrd.exe
-c <path_to_license>/<license_file>.lic -l <path_to_license>/
<log_filename>.log.

Serve Client Machines Pointing to a Floating License

IMPORTANT! The following workflow is only applicable for Windows.

For Linux operating systems, licensing environment variables cannot be set using the Vivado License
Manager (VLM). The environment variable fields are read only, so they are grayed out and there are
no Set buttons. The environment variable must be set using the appropriate OS shell and commands.

1. Run the Vivado License Manager (VLM).

2. Under Manage License, click Manage License Search Path.

3. In the XILINXD_LICENSE_FILE field, enter the network path to the license server in the
<port>@<server> format.

4. Click Set. The default AMD port number is 2100.

Managing Licenses
Managing Licenses with the Vivado License Manager
The Vivado License Manager (VLM) assists with license generation for Certificate-based licenses
only. The Vivado License Manager is installed with the Vivado Edition and many standalone tool
installations. The following figure shows the VLM.
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Figure 1: Vivado License Manager

Vivado License Manager typically performs these tasks:

• Obtaining A License: Choose from several license options and go to the AMD Product
Licensing Site to complete the license generation process.

• Viewing License Status: See which licenses are visible to the local machine. This is a useful
view for debugging licensing issues.

• Loading Licenses Onto a Local Machine: After a certificate license (.lic) file is received, it can
be placed into the appropriate location on the machine. For step-by-step instructions, see the
Installing Your License key section for your license type below.
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• Viewing and Setting (Windows) License Search Locations: Vivado tools look into several
default locations to try to find the authorization to run. If your license is located elsewhere on
the machine or on a floating license server, a path to that license must be specified.

RECOMMENDED: Use the XILINXD_LICENSE_FILE environment variable to specify AMD license file
locations. LM_LICENSE_FILE can also be used, but is mainly intended for non-AMD or legacy license
path use.

Managing Licenses on the AMD Product Licensing
Site
The AMD Product Licensing site tracks the licenses that you generated. To view all licenses you
generated in your product licensing account, select the Manage Licenses tab.

Figure 2: Manage Licenses

Information regarding the licenses in your product licensing account are displayed in a split-
section view. To view detailed information about the licenses in the detail view in the bottom
table, click a row in the master view in the top table. The detail view table displays the following
information:

• A list of product entitlements enabled by file.

• Comments associated with the file.

The detail view table allows you to perform the following actions:

• Download ( ): Download your license file if it does not arrive through email.

• Email ( ): Email the license file emailed to you or another user.

• View ( ): View the actual license file.
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• Delete ( ): Delete the license file. After a file is deleted, the entitlement then becomes
available on the Create New License page and can be regenerated for another host ID.

• Download (View EULA): View the end user license agreement (IP only).

Modifying Licenses

To modify an existing certificated-based license, select the license file in the master view.

You can modify a certificated-based license by doing the following:

• Delete license files and place the entitlement back onto your account.

• Rehost or change node-locked or license server Host IDs.

• Add or remove seats to an existing license product entitlement.

• Add or remove product entitlements from a license key.

Delete Entire License File and Place Entitlement Back Onto Your Account

1. From the Manage Licenses Tab, select the license file you want to delete.

2. Click the Delete button ( ) located below and to the left of the license file details.

3. Click Accept button to accept the Affidavit of Destruction.

All license seats in the entire license file are deleted, and the entitlements are returned to your
account.

Reclaiming Deleted License Components

One of the following actions deletes a product entitlement:

• Changing the license server host for a license key file.

• Removing seats from an existing licensed product entitlement.

• Deleting product entitlements from a license key file.

When you delete seats or remove products from your certificate-based license files, your
licensing account reallocates the entitlement. It increases the number of entitled seats in the
Create New Licenses tab by the same number of seats you deleted from existing license files.

Before the reallocation of entitlement occurs, you must first agree to an Affidavit of Destruction.
This legal agreement is required to ensure the deactivated product entitlements are no longer
being used.

The number of allocation operations is recorded for each user. Administrators can reallocate
product entitlements five times per major release. End users can reallocate product entitlements
three times per major release.
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Rehost: Change Node-Locked or License Server Host ID for a License File

1. From the Manage Licenses Tab, select the license file to rehost.

2. Click Modify License.

The Modify License screen displays.

3. Go to System Information.

4. Change or add new Host ID and/or Host Name by using the drop-down list and text entry
boxes.

5. Click Next twice and then click Accept to accept the Affidavit of Destruction.

Add or Remove Seats to an Existing License Product Entitlement

For floating licenses, you can change the Requested Seats field and add seats up to the total
number of seats available in your entitlement.

1. From the Manage Licenses tab, select the license file to add or remove seats.

2. Click Modify License.

The Modify License screen appears.

3. Go to Product Selection.

4. Click Next twice.

If you removed seats, accept the Affidavit of Destruction.

Note: No Affidavit of Destruction is required for adding seats.

Add or Remove Product Entitlements from a License Key File

1. From the Manage Licenses tab, select the license file to add or remove features/entitlements.

2. Click Modify License.

The Modify License screen appears.

3. Go to Product Selection.

4. Check boxes of any entitlements you want to add or remove from this license file.

5. Click Next button twice.

If you removed features, accept the Affidavit of Destruction.

Note: No Affidavit of Destruction is required for adding features.

Modifying a key file uses the same input form as when the license key file was created,
except that additional product entitlements of the same license type (floating or node-locked)
are made available for adding to the license file.
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Understanding Your Tool and IP Orders

The Orders tab displays information regarding the purchasing orders that created the
entitlements you see in this account.

• The left panel of the screen lists AMD order numbers.

• Order Details populate on the right panel of the screen when you highlight a specific order.

• Select only one order at a time.

• The order’s shipping address information is visible even when product is delivered
electronically.

Figure 3: Orders

Managing User Access to the Product Licensing Account

The Manage Users tab displays information regarding the user access to the product licensing
account. From this tab, you can add or remove users. You can transfer or share the responsibility
of administering a product licensing account with another user.
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Figure 4: Manage Users

Add Users

1. Select the Manage Users tab.

2. To add a user to your product licensing account, do the following:

a. Enter the corporate email address of the new user.

Note: The email address you provide must be the same email address the user supplied or supplies
when creating their AMD account. If not, you can not be properly recognized when logging in.

If added users have already logged into the Product Licensing Site, their name appears in
the user list. If they have never been to the site, the words Not Yet Registered appears in
the space for their name. After they register, their name is filled in.

b. To grant the new user customer account administrative privileges, select Add as a full
administrator.

c. To grant the new user the ability to generate Floating License, select Allow Floating
Licenses. This option grants full administrative privileges.

If you check Allow Floating Licenses only, the restriction on node-locked keys is lifted,
but the others remain. You cannot check both boxes because it is not allowed. Full
administrators already have floating license generation capability.

In some instances, a customer account administrator wants the design team members to
administer the license key files for their own use. By leaving both Add as full administrator
and Allow Floating Licenses check boxes unchecked, you grant the user the following
restricted privileges:

• User can generate node-locked license keys only.

• User can view and modify only those license key files they generated for themselves.

• User cannot manage users.
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Remove Users

1. Select the Manage Users tab.

2. To remove administrative or floating license generation privileges from a user, uncheck the
Administrator or Floating check box for that user.

3. To remove a user from a product licensing account, click the Delete button for that user.

Licensing Overview

Product Licensing Account Overview

When you purchase a design tool edition or IP product from AMD, you are purchasing a license
to use and receive updates for that product for one year. The license to use AMD design tools
and IP products is managed through the use of product entitlements. A product entitlement
determines the following:

• The product that was purchased

• The number of seats purchased

• The license type (certificate based, floating, or node-locked)

• The product subscription period (product updates are provided throughout the year)

In addition to managing the product entitlements for your purchased design tools and IP, you can
also access product entitlements for No Charge or Evaluation products.

Note: All evaluation licenses can now be obtained twice per year.

• Full and No Charge licenses have a subscription period of one year

• Design tools evaluations are for 30 days

• IP evaluations are for 120 days

Generating a license from a product entitlement results in one or more license keys being
generated by the website. When installed, the license keys enable the use of the design tools and
IP that were purchased or are being evaluated. Your product entitlements and resulting license
key files are managed in a product licensing account on the AMD website.

Product licensing accounts are specific to the individual listed on the AMD Software Purchase
Order, who is either the end-user or administrator of the design tools. A single administrator can
manage all purchases in the same product licensing account. Multiple accounts can be managed
by different administrators within a company site, which is useful when multiple design teams
work on different projects with separate budget pools.

Note: You can generate a license for an expired product entitlement; however, it only enables product
releases up to the subscription end date. If you apply a product update released after the subscription end
date of your license, the tool will display a licensing error the next time you use it.
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AMD LogiCORE IP License Generation in the AMD Design Tools

Any LogiCORE IP and design tools entitlements you purchased appear in your list of entitled
products when you log into the Product Licensing Site. Currently, all IP entitlements generate
certificate-based licenses. Licenses for Evaluation and No Charge IP are available on the site in a
separate area. You can now generate licenses for all your certificate-based design tools and IP in
one pass. They are emailed to you in a single license file.

What Happens to Your License Key File

Each time a license is generated for a product entitlement, a FLEXnet increment line and
corresponding package line is added to the license key file. When a license key file is modified to
add seats for an existing or new product entitlement, additional increment or package lines are
added to the license key file.

When a license key file is rehosted or is modified to delete seats or product entitlements, the
corresponding increment lines are regenerated or removed from the modified license key file.

User Type and Actions

There are three user types for the Product Licensing Site: customer account administrator, end
user, and no-charge user.

Customer Account Administrator

An example of a typical customer account administrator is a CAD tools manager. Every product
licensing account must have at least one customer account administrator. A customer account
administrator can manage more than one product licensing account.

The responsibilities of a customer account administrator include the following:

• Generating node-locked or floating licenses for AMD design tools and IP products.

• Adding and removing users from the product licensing account.

• Assigning administrative privileges to other users.

The original customer account administrator is the Ship To contact identified during the product
ordering process. That person receives an email with instructions on how to download and
license each purchased product. The customer account administrator must follow the link in the
email, to ensure access to the purchased products.
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End User

Adding end users to a product licensing account allows an engineer or design team member
the flexibility to manage and generate license keys on their own. The end user can generate
license keys for node-locked products entitlements within the account, evaluation, and “no
charge” license keys for design tools and IP products. A customer account administrator can also
configure the end user account to allow an end user to generate floating licenses. An end user
cannot:

• View or generate floating license keys by default. This privilege can be assigned to them by
the customer account administrator.

• View the license keys generated by other users.

• Add or remove other users to or from the product licensing account.

No-Charge

No-Charge users can perform the following actions:

• Generate a 30-day free evaluation license key that enables Vivado ML Enterprise Edition.

• Generate a 30-day free evaluation license that enables AMD Vitis™ HLS.

• Generate license keys for evaluation and no charge IP products.

All user types can download products electronically.

Note: A customer who is already licensed for a full version of an AMD Design Tools product edition can
evaluate other AMD Design Tools product editions or IP. These product entitlements are made available in
the same product licensing account.

Accessing the AMD Product Licensing Site

You can access the AMD Product Licensing Site in various ways depending upon the type of
license being generated.

If you purchased products which use certificate-based licenses, follow the link included in
your order confirmation email. It provides direct access to an account containing your product
entitlements.

• To evaluate the Vivado Design Suite products, go to the Vivado ML Editions page.

• To evaluate IP products, go to Intellectual Property page and follow the Evaluate link on the IP
product page of interest.

• To access the Product Licensing Site directly, go to https://account.amd.com/en/forms/
license/license-form.html. By directly accessing the site, you can create certificate-based
licenses and perform license account management functions.
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Using the AMD Product Licensing Site

The AMD Product Licensing site is an online service for licensing and administering evaluation
and full copies of AMD design tools and intellectual property (IP) products.

Using the AMD Product Licensing site, you can do the following:

• Create certificate-based licenses

• Manage licenses

• Review license order information

• Manage users

Changing AMD User Account Information

It is important to keep your AMD User Account up to date. As you change companies, addresses,
or emails can change.

Modify Your Corporate Email Address

1. Go to https://www.amd.com/en.html.

2. Click Sign In.

3. Click Edit Profile.

4. Enter your new corporate email address in the Enter new Corporate email address box.

5. Click Update button for changes to take effect.

Certificate-Based Licensing

AMD enforces the AMD End-User License Agreement at runtime in the AMD design tools using
certificate-based licensing.

A certificate, commonly referred to as a “license file (.lic)” is issued from the AMD Product
Licensing Site. The certificate is matched to a given machine, server, or licensing dongle using
your entering host-id which uniquely identifies the machine. This license certificate must remain
present on the machine and in the license search path, because the Vivado tools need access to
this file to check for a valid license feature during runtime.

Note: Flex-ID Dongle licensing for AMD Software is supported only on Windows platforms.

Certificate Licensing Terminology

• Host ID: An identifier, placed within certificate licenses, which binds the license to the
computer using this identifier. Typical identifiers are: Hard-drive volume ID, Ethernet port
MAC address, or USB Dongle ID.

• Node-Locked License: A node-locked license allows for the use of a single seat of a product
entitlement on a specific machine.
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• Floating License: A floating license resides on a network server and enables applications to
check out a license when they are invoked. At any one time, the number of licenses for
simultaneous users is restricted to the number of license seats purchased.

• License Rehosting: The act of changing the host ID of a generated license due to machine
hardware changes, hard-drive failure or the moving of a license from one machine to another.

• License Deletion: The act of removing a license from a machine, and having the entitlement
placed back into the AMD Product Licensing Account.

• Affidavit of Destruction: Click-through agreement by which you certify that the license file
(.lic) for a rehosted or deleted license will be destroyed and no longer used.
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Chapter 4

Download and Installation
This section explains how to download and install the AMD Vivado™ Design Suite Tools. The
AMD Vivado™ Design Suite Tools include the full complement of Vivado Design Suite tools for
design, including C-based design with AMD Vitis™ HLS, implementation, verification, and device
programming. The install includes complete device support, cable drivers, and Documentation
Navigator. You can add Vitis Model Composer which is an AMD toolbox for MATLAB® and
Simulink® to design for AI Engines and Programmable Logic. If using AMD System Generator for
DSP, you can continue development using Vitis Model Composer.

Installer Download Options
AMD Design Tools users have multiple choices for download and installation.

All Editions and download options are available on the AMD Downloads Website.

AMD introduced Vivado Lab Edition, which features a dedicated and streamlined environment
for programming and debugging devices in lab settings.

AMD introduced the Power Design Manager which is a standalone design tool used to estimate
the power requirements of Versal and UltraScale+ devices and AMD Kria™ products. It supports
the Xilinx Power Estimator (XPE) file exchange format for importing data from Vivado and XPE.

TIP: You do not need a license to use Vivado Lab Edition tools.

To install one of the full Vivado Editions, you have three choices.

Vivado Design Suite - ML Editions:

• AMD Unified Installer for FPGAs & Adaptive SoCs 2025.2: Windows Self Extracting Web
Installer

• AMD Unified Installer for FPGAs & Adaptive SoCs 2025.2: Linux Self Extracting Web Installer

• Vivado ML 2025.2: All OS Installer Single-File Download
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AMD Unified Installer for FPGAs & Adaptive
SoCs

The AMD Unified Installer for FPGAs & Adaptive SoCs allows users to install multiple AMD tools
using single installer.

Tools available for installation include:

• Vitis Unified Software Platform

• Vivado Design Environment

• On-premise Install for Cloud Deployments

• Bootgen

• Lab Edition

• Hardware Server

• Power Design Manager (PDM)

• PetaLinux

• Documentation Navigator
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Figure 5: Product Installation

The AMD Unified Installer for FPGAs & Adaptive SoCs is available to download on the AMD
Downloads Website.

Download the Installation File
For the optimum download experience, ensure the following settings are configured:

• Allow pop-up from https://www.o-ms.com/.

• Set security settings to allow for secure and non-secure items to be displayed on the same
page.

To download the Vivado Design Suite, follow these steps:

1. Go to the AMD Downloads Website.

2. Click an installation file to download it.

• To download a full edition of the Vivado Design Suite, choose from the following options:
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○ AMD Unified Installer for FPGAs & Adaptive SoCs 2025.2: Windows Self Extracting
Web Installer

○ AMD Unified Installer for FPGAs & Adaptive SoCs 2025.2: Linux Self Extracting Web
Installer

○ Vivado ML 2025.2: All OS Installer Single-File Download

Note: The Full Edition installers work only on 64-bit machines.

• To download the Vivado Lab Edition tools, select a version of Vivado from the list and
scroll to the Vivado Lab Solution section to download for Windows or Linux.

Related Information

Installer Download Options

Download Verification
After downloading the installation file, you can complete download verification to prove the
authenticity and integrity of the downloaded installation file with a fair degree of certainty. This
step is completely optional but highly recommended. You can skip this step and continue with
the installation.

• Authentication validates that downloaded file was created by the signee, in this case signee is
AMD Inc. Shows that the downloaded file is not forged by a third party.

• Integrity validates that contents of downloaded file are not tampered by third party.
Download verification allows users to validate if the downloaded file indeed is prepared by
AMD and if the contents of the downloaded file is altered or not.

The Digest, Signature, and Public Key options are provided on download page for the purpose of
download verification.

There are two ways to verify the authenticity and integrity of downloaded files. You can choose
one or both of the following methods to ensure the authenticity and integrity of downloaded
files.

• Verify the Signature

• Verify the Digest

For both of the above methods, before you can verify and authenticate the downloaded file, you
must download, import, and trust the public key.

Download, Import, and Trust the AMD Public Key
1. Download the AMD public key.
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a. Go to the AMD Downloads Website.

b. In Download Verification, click the Public Key for the installer you have selected to
download. There is a separate public key for each installer file.

This downloads xilinx-master-signing-key.asc.

c. Confirm the download and import of the AMD public key.

2. To import the key, enter the following command: gpg --import ./xilinx-master-
signing-key.asc

gpg --import ./xilinx-master-signing-key.asc
gpg: keybox '/home/myuser/.gnupg/pubring.kbx' created
gpg: /home/myuser/.gnupg/trustdb.gpg: trustdb created
gpg: key 0x85D4B4BB1D692FDB: public key "Xilinx, Inc. (Xilinx Software 
signing key) <software@xilinx.com>" imported
gpg: total number processed: 1
gpg:               imported: 1
myuser@mymachine:4

3. Set the trust level to ultimate. This allows verification of the key signed by AMD.

a. First, enter the following command to list the public keys: gpg --list-keys

gpg --list-keys
/home/myuser/.gnupg/pubring.kbx
-------------------------------
pub   rsa4096/0x85D4B4BB1D692FDB 2018-04-10 [SC]
      Key fingerprint = 745F 4D5B 2402 441F 410F BD0D 85D4 B4BB 1D69 
2FDB
uid                   [ unknown] xilinx, Inc. (Xilinx Software 
signing key) <software@xilinx.com>
sub   rsa4096/0xE80A66CA2B176EF9 2018-04-10 [S]
sub   rsa4096/0xF991913DFE46B839 2018-04-10 [E}
sub   rsa4096/0xC93822D0B9087126 2018-04-10 [A]
myuser@mymachine:$

b. To specify the key to edit, enter the following command: gpg --edit-key
0x85D4B4BB1D692FDB

gpg --edit-key 0x85D4B4BB1D692FDB
gpg (GnuPG) 2.1.15; Copyright (C) 2016 Free Software Foundation, Inc.
This is free software: you are free to change and redistribute it. 
There is NO WARRANTY, to the extent permitted by law. 

pub  rsa4096/0x85D4B4BB1D692FDB
     created: 2018-04-10  expires: never      usage: SC
     trust: unknown       validity: unknown
sub  rsa4096/0xE80A66CA2B176EF9
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     created: 2018-04-10  expires: never      usage: S
sub  rsa4096/0xF991913DFE468839
     created: 2018-04-10  expires: never      usage: E
sub  rsa4096/0xC93822D0B9087126
     created: 2018-04-10  expires: never      usage: A
[ unknown] (1). Xilinx, Inc. (Xilinx Software signing key) 
<software@xilinx.com>

c. Enter the following command to set the trust level for the legitimate key: trust

gpg> trust
pub  rsa4096/0x85D4B4BB1D692FDB
     created: 2018-04-10  expires: never      usage: SC
     trust: unknown       validity: unknown
sub  rsa4096/0xE80A66CA2B176EF9
     created: 2018-04-10  expires: never      usage: S
sub  rsa4096/0xF991913DFE468839
     created: 2018-04-10  expires: never      usage: E
sub  rsa4096/0xC93822D0B9087126
     created: 2018-04-10  expires: never      usage: A
[ unknown] (1). Xilinx, Inc. (Xilinx Software signing key) 
<software@xilinx.com>

Decide how far you trust this user to correctly verify other users' 
keys
(by looking at passports, checking fingerprints from different 
sources, etc.)

  1 = I don't know or won't say
  2 = I do NOT trust
  3 = I trust marginally
  4 = I trust fully
  5 = I trust ultimately
  m = back to the main menu
      

d. Enter 5 at the prompt.

Your decision? 5
Do you really want to set this key to ultimate trust? (y/n) y

pub  rsa4096/0x85D4B4BB1D692FDB
     created: 2018-04-10  expires: never      usage: SC
     trust: ultimate       validity: unknown
sub  rsa4096/0xE80A66CA2B176EF9
     created: 2018-04-10  expires: never      usage: S
sub  rsa4096/0xF991913DFE468839
     created: 2018-04-10  expires: never      usage: E
sub  rsa4096/0xC93822D0B9087126
     created: 2018-04-10  expires: never      usage: A
[ unknown] (1). Xilinx, Inc. (Xilinx Software signing key) 
<software@xilinx.com>
Note that the shown key validity is not necessarily correct
unless you restart the program.

gpg> q
myuser@mymachine:$

Now that you downloaded, imported, and trusted the AMD public key, you can ensure the
authenticity and integrity of the downloaded file by verifying the signature or verifying the
digest.
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Note: You can pick one or both of methods to ensure the authenticity and integrity of downloaded file.

Verify the Signature
To verify the downloaded file that matches its signature, download the signature file.

1. Go to the AMD Downloads Website.

2. In the Download Verification area, select Signature for the applicable download type.

3. Download and save the signature file.

4. Run the following command to verify the signature:

gpg -v --verify 
FPGAs_AdaptiveSoCs_Unified_20XX.Y_MMDD_HHMM_Lin64.bin.sig 
FPGAs_AdaptiveSoCs_Unified_20XX.Y_MMDD_HHMM_Lin64.bin

Verify the Digest
This is an alternative verification method to ensure the authenticity and integrity of the
downloaded file. This method uses the “digest” or “hash values” which is the output of various
cryptographic hash functions. The current digest file support MD5, SHA1, SHA256, SHA512
hashing algorithms.

1. Go to AMD Downloads Website.

2. In the Download Verification area, select Digest for the applicable download type.

3. Download and save the digest file.

4. After downloading and storing the digest file, authenticate the digest file to make sure that it
is indeed coming from AMD, Inc.

a. Run the following command to verify the signature that ensures that digest file is indeed
coming from AMD Inc.

gpg -v --verify 
FPGAs_AdaptiveSoCs_Unified_20XX.Y_MMDD_HHMM_Lin64.bin.digests

5. After the authentication is complete, verify the digest using either a hashing executable or
OpenSSL.

• To verify the digest using hashing executable – sha256, run the following command:

sha256sum -c 
FPGAs_AdaptiveSoCs_Unified_20XX.Y_MMDD_HHMM_Lin64.bin.digests

Note: You can use other hashing executables as well such as md5sum, sha1sum, and sha512sum.

• To verify the digest using OpenSSL, run the following command:

openssl dgst -sha256 
FPGAs_AdaptiveSoCs_Unified_20XX.Y_MMDD_HHMM_Lin64.bin
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Output of the command is a computed hash value that you need to compare to the
contents of the digest file.

Installing the Vivado Design Suite Tools
This section explains the installation process for all platforms for the Vivado Design Suite.

Installation Flow
Lab Edition, Full Product Download, or Web Installer

If you downloaded the Lab Edition or full product installation, decompress the file, and then run
xsetup (for Linux) or xsetup.exe (for Windows) to launch the installation.

RECOMMENDED: AMD recommends the use of 7-zip or WinZip (v.15.0 or newer) to decompress the
downloaded tar  file.

Lightweight Installer Download

If you downloaded the lightweight installer, launch the downloaded file. You are prompted to log
in and use your regular AMD login credentials to continue with the installation process.

Note: On Linux the file is a .bin file and is launched by running ./<name of the file>.bin. Ensure
that you change the file permissions to execute.

After entering your login credentials, select between a traditional web-based installation or a full
install image download.

• Download and Install Now: Allows you to select specific tools and device families on following
screens, downloads only the files required to install those selections, and then installs them
for you.

• Download Image (Install Separately): Requires you to select a download destination and
to choose whether you want a Windows only, Linux only, or an install that supports both
operating systems. You also have an option to either download the full installer or download
only selected products. Full Image selection has no further options. Installation requires
running xsetup from the download directory.
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Figure 6: AMD Unified Installer for FPGAs & Adaptive SoCs - Select Install Type

Prepare to Install the Tools
You must perform these actions prior to installation.

TIP: To reduce installation time, disable anti-virus software.

1. Check the links described in Important Information for any installation issues pertaining to
your system or configuration.

2. Ensure your system meets the requirements described in Chapter 2: Requirements and Setup.

3. Close all open programs.

Run the Installation File
Use the installation file you downloaded to install the Vivado development environment.

1. Run the installation file, which opens the Unified 2025.2 Installer.

2. Click Next.
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3. Enter your account credentials.

4. Select Download and Install Now, and then click Next.

5. Select a product to install.

6. Click Next.

7. Select the required devices or device families.
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Note: For Versal device families, you can now choose individual devices based on your specific
requirement.

8. Customize the installation by choosing the design tools, device families, and installation
options. Selecting only what you need helps minimize the download and installation for each
product.

9. Read and accept the license agreements.

To indicate that you accept the Xilinx Inc. End User License Agreement, click I Agree.

To indicate that you accept the Third Party Software End User License Agreement, click I
Agree.

After accepting all license agreements, click Next.
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10. Select the installation directory.

11.

CAUTION! The installation directory path must not contain any spaces.

TIP: The installer creates the log files in following location:
Linux: ~/.Xilinx/xinstall/xinstall_123456789.log  and Windows:
C:\Users\<user_name>\.Xilinx\xinstall\xinstall_123456789.log.

12. (Optional) Select shortcut and file association options.

13. Click Next.

An Installation Summary window appears, describing the following information:

• Devices

• Design tools

• Installation options

• Installation locations

• Download locations

• Disk space requirements

14. After reviewing the installation summary, click Install.

Using Download Image (Install Separately) Option

You can download the installer image and install it later by selecting the Download Image (Install
Separately) option.
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1. Provide the destination path (which does not have any other files) and choose the platform
for which you want the installer. You can select a zip archive to get a zip file of the same
installer.

2. Select the image contents:

• Full Image: Download the entire installer.

• Selected Product Only: Download only the files necessary for the selected tools/devices.

Adding Additional Tools and Devices

You can incrementally add additional tools, devices, or even upgrade Vivado editions post-install.
This is useful for users that have chosen to install a subset of devices and/or tools.

To add new tools or devices compatible with Windows, Linux, and command line interfaces:

• For Windows clients, click the Start menu, and select Add Design Tools or Devices <version>.

• For Linux clients, select Vivado → Help → Add Design Tools or Devices.

• For command line, run the below command to launch installer in Upgrade mode: <Install
path>/.xinstall/202x.x/
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If you installed the Vivado ML Standard or ML Enterprise Edition, you can upgrade the edition.

Figure 7: Vivado Design Suite Upgrade - Select Edition

The current installation selection presents all available tools and devices.

You can also add tools or devices from the AMD Information Center (XIC).

Apply Updates in Batch Mode

You can add devices or tools to an existing installation in batch mode using the steps below.

Linux:

Generate the install configuration file using the below command:

<Install path>/.xinstall/<version>/xsetup -b ConfigGen

Modify the generated install configuration file based on the requirement. Run the below
command to upgrade in batch mode:

<Install path>/.xinstall/<version>/xsetup -a XilinxEULA,3rdPartyEULA -b Add 
-c <Path to the install configuration file>
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Windows:

Generate the install configuration file using the below command:

<Install path>\.xinstall\<version>\bin\xsetup.bat -b ConfigGen

Modify the generated install configuration file based on the requirement. Run the below
command to upgrade in batch mode:

<Install path>\.xinstall\<version>\bin\xsetup.bat -a 
XilinxEULA,3rdPartyEULA -b Add -c <Path to the install configuration file>

Resolve Internet Connection Issues
If there are connectivity issues, verify the following:

1. If you are using alternate proxy settings to the ones referred to, click the Change Proxy
Settings button to specify the settings.

2. Check whether your company firewall requires a proxy authentication with your user name
and password. If so, click the Change Proxy Settings button in the dialog box above.

Core/CPUs Setting and Disk Usage Settings
1. Core/CPUs Setting and Disk Usage Settings:

• You can modify CPU bandwidth for the download and installation in the CPU/Core
settings under Preferences.
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Installing Cable Drivers
On Windows, Install Cable Drivers is an optional selection in the installer.

The installer for Linux begins removing this option, starting with Vivado 2015.4, due to requiring
root or sudo access to install drivers for Linux. You can run the general Vivado installer on Linux
without root or sudo privileges. To install cable drivers on Linux, you must now run a script as
root or with sudo post-installation:

• Script Location: <Vivado Install Dir>/data/xicom/cable_drivers/lin64/
install_script/install_drivers/

• Script Name: install_drivers

Install Cable Drivers

1. To install the Windows driver, do the following:

a. Run the following commands in an Administrator command prompt.

cd %VIVADO_INSTALL_DIR%\data\xicom\cable_drivers\nt64 
install_drivers_wrapper.bat %log_dir%
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Note:

• Set or replace %VIVADO_INSTALL_DIR% with the location of your install directory.

• Replace %log_dir% with the location of the log directory.

2. To install the Linux driver, do the following:

a. Enter the following commands as root:

cd ${vivado_install_dir}/data/xicom/cable_drivers/lin64/
install_script/
install_drivers/

./install_drivers

Note: Replace ${vivado_install_dir} with the location of your install directory. If
you do not specify %log_dir%, is not specified, the installer places a file named
install_drivers_wrapper.log under %VIVADO_INSTALL_DIR% of your Vivado install
location.

Uninstall Cable Drivers

• To uninstall the cable driver on a Windows 10 and Windows 11 client, run the following
commands in an Administrator command prompt:

cd %VIVADO_INSTALL_DIR%\data\xicom\cable_drivers\nt64 
&& .\dlc10_win7\wdreg.exe -inf .\dlc10_win10\xpcwinusb.inf uninstall

Note: Set or replace %VIVADO_INSTALL_DIR% with the location of your install directory.

• To uninstall the products on a Linux client, run the following commands as root:

rm -f /etc/udev/rules.d/52-xilinx-digilent-usb.rules rm -f /etc/
udev/rules.d/52-xilinx-ftdi-usb.rules rm -f /etc/udev/rules.d/52-xilinx-
pcusb.rules

Uninstalling the Vivado Design Suite Tool
Before uninstalling the AMD Vivado™ Design Suite, make sure to move any project files you
want to keep to a location outside the tool's installation directory. This prevents accidental
deletion of your files during the uninstallation process.

The uninstaller does not remove the AMD Information Center and Documentation Navigator.
AMD designed both as standalone applications for use with multiple versions of AMD tools.

Uninstall the applications separately if you no longer need them. You can uninstall through
the corresponding entry in the Start Menu program group. For Windows, use the "Uninstall or
change a program" control panel option.

In Linux, Uninstalling the AMD Vivado™ Design Suite tool does not need any root privileges if
you have access to that path and there are no instances of the tool open from that installation.
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In Windows, you require Administrator privilege if you plan to uninstall using the command line
options. Uninstalling using XIC does not require any admin privilege.

Uninstall the Vivado Design Suite Tool

IMPORTANT! Version 2025.2 does not allow you to uninstall an individual product from the same
destination. This applies to the uninstallation via both GUI and Batch mode.

IMPORTANT! Before uninstalling, you can move any project files you want to keep outside your AMD
installation directory structure, or the uninstaller deletes them.

Uninstall on Windows

To uninstall any AMD product, select the Uninstall item from that product’s Start Menu folder.

For instance, to uninstall Vivado Design Suite: Edition, select Start → All apps → Xilinx Design
Tools → Uninstall 2025.2.

GUI Mode

You can use the following command line option to uninstall in GUI mode:
<install_path>\.xinstall\2025.2\xsetup.exe -Uninstall

Batch/Silent Mode

You can use the following command line option to uninstall in Batch/Silent mode:
<install_path>\.xinstall\2025.2\xsetup.exe -b Uninstall

XIC to Uninstall

Uninstall the tool by launching XIC and using the respective Uninstall option under Manage
Installs tab, which launches the Uninstaller in GUI mode.
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Alternatively, you can also use the corresponding entry in the Uninstall or change a program
control panel option.

Uninstall on Linux

To uninstall any AMD product on a Linux client, select Applications → Xilinx Design Tools → 
Uninstall 2025.2.

GUI Mode

You can use the following command line option to uninstall in GUI mode:
<install_path>/.xinstall/2025.2/xsetup -Uninstall

Batch/Silent Mode

You can use the following command line option to uninstall in Batch/Silent mode:
<install_path>\.xinstall\2025.2\xsetup.exe -b Uninstall

XIC to Uninstall
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You can uninstall the tool in GUI mode by following the steps provided in the graphical user
interface:

1. Launching XIC.

2. Goes to Manage Installs tab.

3. Clicking Uninstall option.

4. Following the uninstaller instructions.

Network Installations
Installing to a network location provides a way for client machines to access the design tools by
pointing to it on the network drive. To run design tools on the network, the client machines need
the correct setup. This includes environment variables, registry, and program groups pointing to
the network. The following sections describe the procedure for network setups.

Install the Vivado Design Tools on a Linux Client Network

Design tools must source the settings64.(c)sh file from their installation directory to
configure the environment to reference the installed location:

1. To run the design tools from a remotely installed location, run an X Windows display
manager, and include a DISPLAY environment variable.

2. Define DISPLAY as the name of your display.

DISPLAY is typically unix:0.0. This syntax runs tools on host bigben and displays graphics on
mynode's local monitor.

setenv DISPLAY mynode:0.0

xhost = bigbenPC Clients

Install the Vivado Design Tools on a Microsoft Windows Client
Network

1. Install design tools to a PC network server.

Ensure users know the design tool location, can access the installation directory, and have
Administrator privileges for the following steps.

2. On your local client machine, navigate to the directory where the network installation is
located. The path is: network_install_location\.xinstall\<version>. Once in
the specified directory, locate and run the file named networkShortcutSetup.exe.

Running this program sets up the Windows settings batch files and Program Group or
Desktop shortcuts to run the AMD tools from the remote location.
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3. To use Vivado Design Suite, launch the tools from the following designated shortcuts or
applications.

• Program Group or Desktop shortcuts

• Run applications on the network drive

Install to a Mounted Network Drive

The AMD design tools installer places the tools in a directory under ROOT (typically C:\Xilinx).
The installer normally presents this option when installing to a local driver.

To resolve the installer issue, use either:

• A UNC path (for example, \\network_loc\Xilinx\)

• The network mount point (for example, N:\Xilinx)

Note: You cannot browse to the remote mapped drives using the AMD installer. You need to manually type
in your installation path which contains a mapped network drive.

Batch Mode Installation Flow
The installer can run in an unattended batch process. To run the installer unattended, you must
do one of the following.

• Specify a standard edition and installation location

• Include a configuration file that provides the installer with the install location and the tools,
devices, and options you want to install

RECOMMENDED: You can generate this reference for each new release to account for new devices, tools,
options, or other changes in your options file.

To begin using batch mode, open a command shell, and change to the directory where you stored
your extracted installer.

Note: For Windows, open a command window with admin privileges. Run: \\bin\xsetup.bat with the
following options.

Generate a Configuration File

1. Run xsetup -b ConfigGen.

This puts you in an interactive mode, and you see the following menu:
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Type 2, and then press Enter.

2. Make your selection, and enter the location/file name for your configuration file. The
interactive mode then exits. Below is a sample Vivado ML Enterprise Edition configuration
file:
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Each option in the configuration file matches a corresponding option in the GUI. A value of 1
means that option is selected; a value of 0 means the option is unselected.

Running the Installer

After editing your configuration file to reflect your installation preferences, you can run
the installer. The command-line installer requires you to accept the Xilinx End-User License
Agreement (EULA). Your chosen product selects theThird Party End-User License Agreement
notices.

License Agreements

• Vitis Unified Software Platform Third-Party Licensing Guide

• Vitis Unified Software Platform Unified End User License Agreement

• Vivado Hardware Server Third-Party Licensing Guide

• Vivado Hardware Server End User License Agreement

• Vivado ML Third-Party Licensing Guide

• Vivado ML End User License Agreement

• Vivado ML Lab Edition Third-Party Licensing Guide

• Vivado ML Lab Edition End User License Agreement

• Bootgen Third-Party Licensing Guide

• Bootgen End User License Agreement

• DocNav Third-Party Licensing Guide

• DocNav End User License Agreement

• Vitis Model Composer Third-Party Licensing Guide

• Vitis Model Composer User License Agreement

• Vitis Embedded Third Party Licensing Guide

• Vitis Embedded End User License Agreement

• Power Design Manager Third Party Licensing Agreement

• Power Design Manager End User License Agreement
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When using the command line, use the command-line switch, -a or --agree, to indicate your
agreement to each of the above. Omitting an item or not specifying the agree switch causes the
installer to exit with an error.

Batch Mode Installation Using Single-File Download

This is an example of the command line for a typical new installation using a configuration file.

xsetup --agree XilinxEULA,3rdPartyEULA 
--batch Install --config install_config.txt

If using an AMD default configuration, you don't need --config. However, you must specify
the destination directory on the command line.

xsetup --agree 3rdPartyEULA,XilinxEULA 
--batch Install --edition "Vitis Unified Software Platform" --location "/
home/Xilinx"

The above command uses the default configuration options for the edition specified. To see
the default configuration options, use the –b ConfigGen mode as described above. The batch
mode of the installer can also uninstall and upgrade (add additional tools and devices). For the full
list of the options in the installer batch mode, run xsetup -h or xsetup --help.

Batch Mode Installation Using Web Installer
Command line based Web-Installer is a great way to enhance the productivity for installing
AMD Vivado™ tools. It includes all the features as GUI Web-Installer and it allows you to fully
script your installation process. Command line based Web-Installer uses secure token exchange
mechanism to validate the user accounts.

Extract Web Installer Batch Mode Client

Use following command to extract the batch mode client on your Linux machine.

<Download Dir>/FPGAs_AdaptiveSoCs_Unified_202X.Y_MMDD_HHMM_Lin64.bin --keep 
--noexec --target <WI Client Dir>

Note: For Windows, open the command window with administrator privileges and run the xsetup.bat file,
found in the \bin directory, and not xsetup.exe.

For batch mode installation on windows, run following command.

Windows: <Download Dir>/
FPGAs_AdaptiveSoCs_Unified_Web_202X.Y_MMDD_HHMM_Win64.exe -y -gm2 
-nr -InstallPath="<WI Client Dir>" e.g. 
FPGAs_AdaptiveSoCs_Unified_2025.1_1113_2119_Win64.exe -y -gm2 -nr 
-InstallPath="C:\Temp\wi"
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Acquire Authentication Token

To minimize the user interaction, you can use secure token mechanism to authenticate the users.

1. Get an authentication token (from a text file).

2. The web installer uses this token to authenticate the user.

3. This happens before downloading/installing the tool.

This authentication token needs to be acquired (generated) at least one time and expires after 7
days. You must generate/acquire a new token after it expires.

• Use following command to generate authentication token:

OtherDirectory]$ ls bin data lib tps xsetup
rdevl101 OtherDirectory]$ ./xsetup -b AuthTokenGen

• The web installer asks for an AMD Account user ID and password before generating the
authentication token.

./OtherDirectory/xsetup -b AuthTokenGen
This is a fresh install.
Running in batch mode...
Copyright (c) 1986 - 2024 AMD, Inc. All rights reserved.
INFO - Internet connection validated, can conect to internet.
INFO - In order to generate the authentication token, provide your AMD 
account E-mail Address and password.

E-mail Address:amdtest123@gmail.com
Password:
INFO - Generating authentication token...
INFO - Saved authentication token file successfully, valid until 
03/31/2024 11:10 AM

Web Installer Download and Install

Use following command to download and install using command line web installer.

./xsetup -b Install -a XilinxEULA,3rdPartyEULA -c 
<path_to_configuration_file>

Example Command:

/xsetup -b Install -a XilinxEULA,3rdPartyEULA -c ./install_config.txt
This is a fresh install.
Running in batch mode...
Copyright (c) 1986-2024 AMD, Inc. All rights reserved. 
INFO - User has accepted the EULAs.
INFO - Internet connection validated, can connect to internet. 
INFO - Authenticated user amdtest123@gmail.com successfully.
INFO - Installing Edition: Vivado ML Enterprise
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INFO - Installing Edition: Vivado ML Enterprise
INFO - Installation directory is /proj/xresults_dsv/agovinda/Xilinx1

INFO - web-install-services has the files, modifying download host.
Downloading files (5.38 GB / 58.43 GB) 6 minutes left at 191 MB/sec.  |

Updates:

You can only install updates to your existing install using a full image (SFD) or via the notification
in XIC. AMD does not support updates to existing installer via Web Installer.

Obtaining Quarterly Releases
AMD periodically releases tools and tools updates which contains device support updates, new
features and bug fixes. The following sections describe how to obtain updates through the AMD
Information Center.

AMD Information Center

AMD Information Center (XIC) is the next generation replacement of XilinxNotify. This
functionality resides in the task bar (Windows) and periodically checks for new releases and
updates from AMD. You can view notifications and update installations.

In addition, XIC now includes a cockpit from which you can manage all of your AMD tool
installations. Update, check licenses or uninstall all from the new Manage Installs tab as shown in
the following figure.
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Figure 8: AMD Information Center (XIC)
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Appendix A

Additional Resources and Legal
Notices

Finding Additional Documentation
Technical Information Portal

The AMD Technical Information Portal is an online tool that provides robust search and
navigation for documentation using your web browser. To access the Technical Information
Portal, go to https://docs.amd.com.

Documentation Navigator

Documentation Navigator (DocNav) is an installed tool that provides access to AMD Adaptive
Computing documents, videos, and support resources, which you can filter and search to find
information. To open DocNav:

• From the AMD Vivado™ IDE, select Help → Documentation and Tutorials.

• On Windows, click the Start button and select Xilinx Design Tools → DocNav.

• At the Linux command prompt, enter docnav.

Note: For more information on DocNav, refer to the Documentation Navigator User Guide (UG968).

Design Hubs

AMD Design Hubs provide links to documentation organized by design tasks and other topics,
which you can use to learn key concepts and address frequently asked questions. To access the
Design Hubs:

• In DocNav, click the Design Hubs View tab.

• Go to the Design Hubs web page.
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Support Resources
For support resources such as Answers, Documentation, Downloads, and Forums, see Support.

References
These documents provide supplemental material useful with this guide:

1. PetaLinux Tools Documentation: Reference Guide (UG1144)

2. Vitis Model Composer User Guide (UG1483)

3. Vitis Model Composer Tutorial (UG1498)

4. Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973)

5. UltraFast Design Methodology Guide for FPGAs and SoCs (UG949)

6. UltraFast Vivado HLS Methodology Guide (UG1197)

7. Vivado Design Suite User Guide: Logic Simulation (UG900)

8. Vivado Design Suite User Guide: Dynamic Function eXchange (UG909)

9. Vivado Design Suite Tutorial: Dynamic Function eXchange (UG947)

10. Vivado Design Suite User Guide: Model-Based DSP Design Using System Generator (UG897)

11. Vivado Design Suite User Guide: Implementation (UG904)

12. Vivado Design Suite User Guide: Power Analysis and Optimization (UG907)

13. Platform Cable USB II Data Sheet (DS593)

14. AMD Vivado Developer Hub

15. Vivado Documentation

16. PS and PL-Based 1G/10G Ethernet Solution (XAPP1305)

17. Secure Boot of Zynq 7000 SoC (XAPP1175)

18. Model Composer User Guide (UG1262)

Training Resources
AMD provides a variety of training courses and QuickTake videos to help you learn more about
the concepts presented in this document. Use these links to explore related training resources:
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1. Designing FPGAs Using the Vivado Design Suite

Revision History
The following table shows the revision history for this document.

Section Revision Summary
11/20/2025 Version 2025.2

2025.2 Release Updates Editorial updates.

05/29/2025 Version 2025.1

2025.1 Release Update Updated the Supported Operating Systems and Supported
Devices.

Please Read: Important Legal Notices
The information presented in this document is for informational purposes only and may contain
technical inaccuracies, omissions, and typographical errors. The information contained herein
is subject to change and may be rendered inaccurate for many reasons, including but not
limited to product and roadmap changes, component and motherboard version changes, new
model and/or product releases, product differences between differing manufacturers, software
changes, BIOS flashes, firmware upgrades, or the like. Any computer system has risks of security
vulnerabilities that cannot be completely prevented or mitigated. AMD assumes no obligation
to update or otherwise correct or revise this information. However, AMD reserves the right to
revise this information and to make changes from time to time to the content hereof without
obligation of AMD to notify any person of such revisions or changes. THIS INFORMATION IS
PROVIDED "AS IS." AMD MAKES NO REPRESENTATIONS OR WARRANTIES WITH RESPECT
TO THE CONTENTS HEREOF AND ASSUMES NO RESPONSIBILITY FOR ANY INACCURACIES,
ERRORS, OR OMISSIONS THAT MAY APPEAR IN THIS INFORMATION. AMD SPECIFICALLY
DISCLAIMS ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL AMD BE LIABLE TO ANY
PERSON FOR ANY RELIANCE, DIRECT, INDIRECT, SPECIAL, OR OTHER CONSEQUENTIAL
DAMAGES ARISING FROM THE USE OF ANY INFORMATION CONTAINED HEREIN, EVEN IF
AMD IS EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS "XA" IN THE PART NUMBER) ARE NOT
WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS
THAT AFFECT CONTROL OF A VEHICLE ("SAFETY APPLICATION") UNLESS THERE IS
A SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262
AUTOMOTIVE SAFETY STANDARD ("SAFETY DESIGN"). CUSTOMER SHALL, PRIOR TO USING
OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST
SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION
WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY
TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.

Copyright

© Copyright 2012-2025 Advanced Micro Devices, Inc. AMD, the AMD Arrow logo, Alveo,
Artix, Kintex, Kria, Spartan, UltraScale, UltraScale+, Versal, Virtex, Vitis, Vivado, Zynq, and
combinations thereof are trademarks of Advanced Micro Devices, Inc. MATLAB and Simulink
are registered trademarks of The MathWorks, Inc. Other product names used in this publication
are for identification purposes only and may be trademarks of their respective companies.
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